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This document contains information about the Fiery EXP250 Color Server version 1.1 and 
supplements the Fiery EXP250 version 1.0 Customer Release Notes. Before using the 
Fiery EXP250 Color Server with version 1.1, make copies of these 

 

Customer Release Notes

 

 and 
distribute them to all users. 
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This document uses the term “Fiery EXP250” to refer to the Fiery EXP250 Color 
Server. The term “copier” is used to refer to the DocuColor 240/250 copier.

 

Installing software 
from the DVD

 

Installing user software on a Windows computer

 

The procedures below describe installing user software from the DVD and also modifying the 
user software.
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1 Insert the User Software DVD into the DVD drive of your computer.

 

The Welcome screen of the installer is displayed.

 

2 Follow the on-screen instruction

 

If you want to modify or remove any user software after you have installed it on your 
computer, you can do so using the Fiery User Software Installer. The procedure is described 
below.
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1 Insert the User Software DVD into the DVD drive of your computer.

2 In the window that is displayed, select Modify, Repair, or Remove.

3 Follow the on-screen instructions.

 

If your computer does not have a DVD drive, you can install the user software from the 
Fiery EXP250 over the network. See “Installing software over the network” on page 8. Ask 
your network administrator for the IP address or the DNS server name of the Fiery EXP250.

Do not attempt to install user software by opening the individual folders for the applications. 
Always use the Fiery User Software Installer.

The only applications that are not installed by the Fiery User Software Installer are Adobe 
Acrobat and PitStop for use with Impose. For more information, see 

 

Utilities

 

.

 

Installing user software on a Mac OS computer

 

Installation of user software on a Mac OS computer is done separately for each application. 
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1 Insert the User Software DVD into the DVD drive of your computer.

2 Browse to the OSX folder.

3 Double-click the installer icon for the application you want to install.

4 Follow the on-screen instructions.
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Installing Windows 2000/XP/Server 2003 printer drivers 

 

The following procedures describe installing the printer driver from the User Software DVD.

To install the printer driver on a Windows Server 2003 computer, select the same PPD file as 
for Windows 2000 and Windows XP, described in the following procedure.

To use the printer driver on Windows 2000/XP/Server 2003, you must select the following 
options in the Advanced tab of the printer driver after installation is complete:

• Spool print documents 

• Start printing immediately

• Print spooled documents first

Clear the following option:

• Enable advanced printing features
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The following procedures use Windows XP illustrations. 
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1 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Windows 2000/XP: Double-click the Add Printer icon and click Next.
Windows Server 2003: Choose Add a printer and click Next.

3 Specify printing using a local printer, clear the “Automatically detect and install my Plug and 
Play printer” box, and click Next.

 

This procedure describes the installation of a local printer. You can modify the connection 
later, according to your network type.

 

4 Select LPT1: and click Next.
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5 Click Have Disk in the dialog box displaying lists of manufacturers and printers.

 

The Install From Disk dialog box prompts you for the disk.

 

6 Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for 
example, D:\), and click Browse. Browse to the English\Prntdrvr\Ps_drvr\Win_2K_XP folder.

7 Make sure that Oemsetup.inf or Oemsetup is selected and click Open. 

 

The path is copied to the Install From Disk dialog box.

 

8 Verify that the path is correct and click OK.

9 In the Printers box, select the Fiery EXP250 as your printer and click

 

 

 

Next.

10 Type a name for the Fiery EXP250 in the Printer name field, indicate whether you want to 
make it the default printer, and click Next.

 

This name is used in the Printers window and the queues window.

 

11 Follow the on-screen instructions.

 

Do not share the printer and do not print a Test Page at this time. Continue with the printer 
driver installation and at the last screen, click Finish.

The necessary files are installed on your hard disk. When installation is complete, the Printers 
window appears with an icon for the newly installed printer. 
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Installing Mac OS X printer drivers and printer description files

 

The User Software DVD contains the following software for Mac OS X (see the OSX: Printer 
Driver folder):

• OSX Installer: Installs the PostScript Printer Description files (PPDs) and PPD plug-ins 
required to print from Mac OS X.

• Language folders: Printer description files that are installed by OSX Installer. You do not 
need to open these folders or install them manually on your computer. The appropriate 
files are installed by OSX Installer.
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1 Quit all open applications.

2 Make sure that the Printer Setup Utility (or Print Center) is not running on your computer.

 

Printer Setup Utility (or Print Center) updates the list of available printers when it restarts. If 
a printer description file is added while Printer Setup Utility (or Print Center) is running, you 
cannot select the associated printer model until you restart.

 

3 Insert the User Software DVD into the DVD drive.

4 Open the OSX: Printer Driver folder on the User Software DVD.

If you are installing from the files you downloaded using the Downloads tab in WebTools, 
browse to the Printer Driver folder on your desktop.

If you are installing from the folder you downloaded from the Fiery EXP250 over the network, 
browse to the Printer Driver folder on your desktop.

5 Double-click the OSX Installer icon to start installing the printer driver.
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The PPD files are installed in the following locations:

On an English system: en.lproj under 
<Startup disk>: Library: Printers: PPDs: Contents: Resources 

On a non-English system: de.lproj, es.lproj, fr.lproj, and it.lproj under 
<Startup disk>: Library: Printers: PPDs: Contents: Resources

If the PPD files are not successfully installed, manually copy the PPD files to the appropriate 
folder or folders.

 

6 Follow the on-screen instructions.

 

The OSX Installer installs the printer driver files that correspond to the Fiery EXP250.

 

7 When copying is complete, click Quit.
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Fonts

 

The fonts on the User Software DVD include screen and printer fonts that correspond to the 
136 built-in PostScript printer fonts on the Fiery EXP250. The screen fonts must be installed 
on Mac OS X to be available to applications.
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In the System: Library: Fonts folder, when displayed by Kind, screen fonts appear as 
type “Font Suitcase” and PostScript printer fonts appear as type “PostScript font.”
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1 Insert the User Software DVD into the DVD drive of the Mac OS X computer.

2 Open the OSX folder on the DVD.

3 Open the Fonts folder and copy the fonts to the following location:

 

• For your personal use: Users/account name/Library/Fonts

• For shared use: Library/Fonts

 

T

 

O

 

 

 

INSTALL

 

 

 

SCREEN

 

 

 

AND

 

 

 

PRINTER

 

 

 

FONTS

 

 

 

ON

 

 M

 

AC

 

 OS 

 

V

 

10.2.

 

X

 

 

 

OVER

 

 

 

THE

 

 

 

NETWORK

 

 

 

1 Choose Connect to Server from the Go menu.

2 Type smb:// followed by the IP address of the Fiery EXP250 and click Connect.

 

If you cannot locate the Fiery EXP250, contact your network administrator.

 

3 Type the user name and password if required.

 

Check with your network administrator to see if this is required.

 

4 Double-click the icon for the Mac_User_SW directory, or select Mac_User_SW and click OK.

5 Open the OSX folder.

6 Open the Fonts folder, and then copy the fonts to the following location:

• For your personal use: Users/account name/Library/Fonts

• For shared use: Library/Fonts
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TO INSTALL SCREEN AND PRINTER FONTS ON MAC OS X V10.3.X

1 Insert the User Software DVD into the DVD drive of the Mac OS X computer.

2 Start the Font Book application in Applications/Font Book.

3 Choose Add Fonts from the File menu.

4 Choose User Software/OSX/Fonts/Albertus MT.

5 Choose Select All from the Edit menu.

6 Choose one of the following from Install fonts:

• For your personal use: for yourself only

• For shared use: for all users of this computer

• For Classic: for Mac OS X Classic

7 Click Open.

8 Exit the Font Book application.

TO INSTALL SCREEN AND PRINTER FONTS ON MAC OS V10.3.X OVER THE NETWORK 

1 Choose Connect to Server from the Go menu.

2 Type smb:// followed by the IP address of the Fiery EXP250 and click Connect.

If you cannot locate your Fiery EXP250, contact your network administrator.

3 Type the user name and password if required.

Check with your network administrator to see if this is required.

4 Double-click the icon for the Mac_User_SW directory, or select Mac_User_SW and click OK.

5 Start the Font Book application in Applications/Font Book.

6 Choose Add Fonts from the File menu.

7 Choose User Software/OSX/Fonts/Albertus MT.

8 Choose Select All from the Edit menu.

9 Choose one of the following from Install fonts:

• For your personal use: for your use only

• For shared use: for all users of this computer

• For Classic: for Mac OS X Classic

10 Click Open.

11 Exit the Font Book application.
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Installing software 
over the network

Documentation, user software, and printer drivers are installed over the network in a shared 
folder during system software installation. Users can connect to the shared folder over the 
network to download documentation, software, and printer drivers.

For information on system software installation, see the Installation and Service Guide.

User Documentation

Documentation can be installed on the Fiery EXP250 by an administrator and then shared 
over the network.

TO INSTALL USER DOCUMENTATION ON THE FIERY EXP250

1 Insert the User Documentation CD into the CD-ROM drive.

A message appears asking if you want to install the user documentation on the Fiery EXP250 
server.

2 Click Yes to install the documentation. If you click No, the contents of the User 
Documentation CD are displayed, but not installed.

3 If you click Yes, the documentation is copied to a shared folder that can be accessed from the 
Fiery EXP250 or from client computers over the network.

NOTE: If the User Documentation CD is inserted after the documentation has been installed, 
the contents of the documentation folder are displayed.

TO INSTALL USER DOCUMENTATION ON A WINDOWS CLIENT OVER THE NETWORK 

1 Browse for the Fiery EXP250 over the network, using either the IP address or the DNS 
server name.

2 Type the user name and password, if required.

Check with your network administrator to see if this is required.

3 Browse to the User_Docs folder.

4 Browse to the language folder you want.

5 Copy the folder to your hard drive.

If there is an Acrobat link, click the Acrobat link to download the documentation from the 
internet. 

TO INSTALL USER DOCUMENTATION ON A MAC OS X CLIENT OVER THE NETWORK 

1 Choose Connect to Server from the Go menu.

2 Type smb:// followed by the IP address of the Fiery EXP250 and click Connect.

If you cannot locate the Fiery EXP250, contact your network administrator.

3 Type the user name and password if required.

Check with your network administrator to see if this is required.
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4 Browse to the User_Docs folder.

5 Browse to the language folder that you want.

6 Copy the folder to your hard drive.

If there is an Acrobat link inside the folder, click the Acrobat link to download the 
documentation from the internet. 

Printer Drivers

You can download printer driver files to your computer directly from the Fiery EXP250 over 
the network and then install them following the procedures in Printing from Windows and 
Printing from Mac OS.

TO DOWNLOAD PRINTER DRIVER FILES ON A WINDOWS CLIENT OVER THE NETWORK

1 Right-click Network Neighborhood or My Network Places, and select Find Computer or Search 
for Computers.

2 Type the name or IP address of the Fiery EXP250 and click Search Now.

If you cannot locate your Fiery EXP250, contact your network administrator.

3 Double-click the name of the Fiery EXP250.

The enabled print connections are displayed along with a folder called FieryUserSW.

4 Double-click the PC_User_SW folder and browse to the English\Prntdrvr\Ps_drvr folder.

5 Copy the Win_2K_XP folder to your desktop.

For information about installing Windows printer drivers, see Printing from Windows.

TO DOWNLOAD PRINTER DRIVER FILES ON A MAC OS X CLIENT OVER THE NETWORK

1 Click the Go menu and choose Connect to Server.

2 Enter smb:// followed by the IP address of the Fiery EXP250 and click Connect.

If you cannot locate your Fiery EXP250, contact your network administrator.

3 Select Mac_User_SW and click OK.

4 Open the folder for your operating system and copy the Printer Driver folder to your desktop.

5 Install the appropriate printer driver for your operating system.

For information about installing Mac OS printer drivers, see Printing from Mac OS.
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User Software

You can install user software to your computer directly from the Fiery EXP250 over the 
network. 

TO INSTALL USER SOFTWARE ON A WINDOWS COMPUTER OVER THE NETWORK 

1 Click Start, choose Run, and type either “\\IP address” or “\\DNS server name” of the 
Fiery EXP250.

2 Type the user name and password, if required.

Check with your network administrator to see if this is required.

3 Double-click the PC_User_SW directory.

4 Double-click the Master Installer icon.

5 Follow the on-screen instructions.

TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER OVER THE NETWORK 

1 Choose Connect to Server from the Go menu.

2 Type smb:// followed by the IP address of the Fiery EXP250 and click Connect.

If you cannot locate the Fiery EXP250, contact your network administrator.

3 Type the user name and password, if required.

Check with your network administrator to see if this is required.

4 Double-click the icon for the Mac_User_SW directory, or select Mac_User_SW and click OK.

5 Open the OSX folder.

6 Double-click the installer icon for the application that you want to install.

7 Follow the on-screen instructions.

Setup Start Page

The copyright year on the Start Page is incorrect. The Start Page should display 2006 as the 
copyright year. 

Tray 5 Media Protection

Enabling and disabling the Tray 5 Media Protection option is only available from the 
Fiery EXP250 Control Panel and from systems that have the Fiery Advanced Controller 
Interface.
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Printing Custom page sizes with imposed jobs

Custom page sized jobs do not print with the specified page size when the job is imposed.

Tray 6 (Oversized)

Manual duplex jobs may not output correctly with Tray 6 (Oversized).

Booklet jobs with Tray 5

Postscript and PCL booklet jobs sent from Windows computers with Cover Source set to 
front and back covers printed on both sides from Tray 5 do not print correctly when Tray 5 
Media Protection is set to On in Setup.

Postscript and PCL booklet jobs sent from Windows computers with Cover Source set to 
front cover printed on front and back cover printed on back from Tray 5 print with extra 
blank sheets when Tray 5 Media Protection is set to On in Setup.

Light font characters may not print

If you calibrate the copier to allow light colors to print, some light font characters may not 
print and others will print even when all characters are equally visible from ImageViewer. The 
same characters do not print regardless of whether you print the page Long Edge Feed or 
Short Edge Feed. 

Media Type and Tray 6 (Oversized)

Tray 6 (Oversized) with Tab Stock 1 or Tab Stock 2 is not supported.

The Fiery EXP250 will not print if you specify Tab Stock 1 or Tab Stock 2 for the media type 
with Tray 6 (Oversized). To print thick media from Tray 6 (Oversized), set Media Type to 
Heavyweight 1, Heavyweight 2, Coated 1, or Coated 2.

Print options Spot Color Matching and Combined Separations

Setting Spot Color Matching to Off with Combined Separations set to On is not supported 
from Mac OS 10.4, even though you can select this combination from the printer driver.

Use Tray 5 (Bypass) for Tab Stock 1 or Tab Stock 2 media types

Printing a job with Media Type set to Tab Stock 1 or Tab Stock 2 is not supported when 
printing from Tray 6 (Oversized). Use Tray 5 (Bypass) to print with Tab Stock 1 or Tab 
Stock 2. To print thick media from Tray 6 (Oversized), set Media Type to Heavyweight 1, 
Heavyweight 2, Coated 1, or Coated 2.

Fiery PPD for 64-bit Windows XP/Server 2003 printer driver

The PPD for the 64-bit version of Windows XP or Windows Server 2003 (available on the 
User Software DVD) allows you to use the standard Windows printer driver to send jobs to 
the Fiery EXP250. You can access the PPD options when you print from an application by 
clicking Advanced in the Printer Properties window. The PPD options are available under 
Printer Features.
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Some print options are not available or are only partially functional, including:

• Tray Alignment

• Centering Adjustment

• Scale

• Preview Master

• Print Mode

• Group Name

• Group Password

• Instructions

• Notes

• Orientation

• Mixed Media Front or Back Cover

• FreeForm

Constraints between two or more settings are indicated with yellow warning icons, but you 
are not prevented from printing a job with settings that conflict.

Two-Way Communication is not available when using this PPD with the standard Windows 
printer driver. You must manually configure the printer driver with any installed options. For 
instructions, see Printing from Windows.

WebTools Enable Windows Printing option

If you do not make any changes in WebTools Setup and click Save from the Service 2 tab, the 
Enable Windows Printing option changes from the default setting of On to Off. To work 
around this, select Enable Windows Printing (setting it back to On) from WebTools Setup 
and click Save again.

Accessing WebTools

The Fiery EXP250 version 1.1 WebTools uses 127.0.0.1 for the IP address and does not 
default to Blank. Microsoft XP SP2 security settings prevent the Fiery EXP250 from using 
localhost to access WebTools.
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Remote Scan Help

Disregard the information in Remote Scan Help about initiating a scan from the Initiate Tab. 
You can only initiate a scan from the copier control panel, as stated in Utilities. Remote Scan 
only allows you to retrieve the scan remotely. 

Command 
WorkStation

Notes field

The Command WorkStation search field displays Notes 1 and Notes 2 fields. However, the 
Fiery EXP250 printer driver only has one Notes field.

Group and Password settings are not applied across two servers

If you set up two different groups on two servers and send a job to the first server with the 
correct group information set, and then connect to the second server and select the job and 
send it to server two, the job will print. However, the job should not print because the group 
settings do not match the second server’s group settings.

Hot Folders Untranslated options

Some options in Mac OS Hot Folders only appear in English, regardless of the language of the 
operating system you are using. Some of the English-only options that display are 1-up Full 
Bleed, 2-up Perfect, Scale to Fit, Custom, and any options under the Finishing tab. In 
addition, some text and tabs may not display at all because the Hot Folders window is not 
proportioned correctly.

Applications Adobe Freehand

Gradients do not overprint from Freehand on Windows XP.

Adobe InDesign and Mirror

Printing from Adobe InDesign using the Mirror printer driver option is not supported. If you 
print from InDesign with this setting enabled, the job is printed without the setting enabled. 
To work around this, use the InDesign Mirror option instead.

Adobe Acrobat Professional

If you print a .pdf file from Adobe Acrobat Professional, the job does not print. It remains 
processing in the queue, and you must restart the Fiery EXP250. To work around this, select 
Print Image in the printer driver, and the .pdf file will print.

Microsoft Word

If you print a Word document with default print options, you receive an error message and 
the job does not print. However, the job prints if you send the job from Publisher.
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Mac OS X 
printer drivers

Two versions of Mac OS X printer driver

The following information replaces the Mac OS X printer drivers section in the 
Fiery EXP250 version 1.0 SP1 User Addendum. 

When you install the Mac OS X printer driver for version 1.1, you can install a Fast 
version, which does not check for incompatible print option settings but runs faster, or 
a Comprehensive version, which prevents you from choosing incompatible print option 
settings at the expense of some processing time. A dialog box in the OS X installer lets 
you choose the version.

The Fast version addresses issues on Mac OS X with folding and stapling. Use the Fast version 
if the copier is configured with a finisher and you want to print folded and/or stapled jobs. Be 
aware that if you choose incompatible print option settings, your job might not print as 
expected. 

If you install the Comprehensive version and then later decide to install the Fast version, 
you must remove the Comprehensive version first, using the procedure described in the 
Fiery EXP250 version 1.0 SP1 User Addendum.


	Installing software from the DVD
	Installing user software on a Mac OS computer
	Installing Windows 2000/XP/Server 2003 printer drivers
	Installing Mac OS X printer drivers and printer description�files
	Fonts

	Installing software over the network
	Setup
	Start Page
	Tray 5 Media Protection

	Printing
	Custom page sizes with imposed jobs
	Tray 6 (Oversized)
	Booklet jobs with Tray 5
	Light font characters may not print
	Media Type and Tray 6 (Oversized)

	Print options
	Spot Color Matching and Combined Separations
	Use Tray 5 (Bypass) for Tab Stock 1 or Tab Stock 2 media types
	Fiery PPD for 64-bit Windows XP/Server 2003 printer driver

	WebTools
	Enable Windows Printing option
	Accessing WebTools

	Remote Scan
	Help

	Command WorkStation
	Notes field
	Group and Password settings are not applied across two servers

	Hot Folders
	Untranslated options

	Applications
	Adobe Freehand
	Adobe InDesign and Mirror
	Adobe Acrobat Professional
	Microsoft Word

	Mac OS X printer drivers
	Two versions of Mac OS X printer driver


